AKVIS Refocus
Focus Adjustment & Blur Effects
akvis.com
CONTENTS

- Field of Application
- Installation on Windows
- Installation on Mac
- Activation
- How It Works
  - Workspace
  - Using the Program
  - Refocus
  - Tilt-Shift
  - Iris Blur
  - Motion Blur
  - Radial Blur
  - Bokeh Effects
  - Preferences
  - Batch Processing
  - Print Image
- Examples
  - Toy World: Tilt Shift Effect
  - Look into My Eyes: Selective Focus
- AKVIS Programs
AKVIS Refocus is focus adjustment software that enhances clarity of photos, increases their sharpness, and applies artistic blur and bokeh effects to images. Improve your pictures and add them aesthetic value with AKVIS Refocus!

Digital cameras are a good companion for capturing everyday moments - they are handy and offer automatic settings that save you time. However, sometimes the camera fails to focus on the subject automatically and it comes out unsharp.

**AKVIS Refocus** will take care of such images. The software improves sharpness of out of focus images. The program can process the entire photo or bring into focus only the selected part to make the subject stand out against the background. It's also possible to add bokeh and lens blur effects to your photos.

The software works in five modes: **Refocus**, **Tilt-Shift**, **Iris Blur**, **Motion Blur**, and **Radial Blur**.

**Refocus** mode makes blurred photos sharp and clear. You can re-focus the entire image or only certain details.

When shooting an object or a landscape at a distance, you may notice that the picture looks hazy. The software will make the photo more distinct and thus more impressive.

Even if a photo looks sharp enough, there is always room for improvement. To draw attention to certain details, you can use **selective focus**.

In digital photography the selective focus technique is used to shoot portraits, macro and close-up photographs. For this purpose, one switches to aperture mode and adjusts the settings till the subject is in focus. With the software you can separate the subject from the background using special tools; to achieve a more realistic selective focus effect you can sharpen one part of the photo and blur the rest (**Deluxe/Business**).
**Tilt-Shift** mode allows leaving a sharp strip in the image, adding gradual blur at the edges, with smooth transitions between the regions and with bokeh effects. This mode gives the objects on the photo a "toy" look. It blurs the outer parts and makes the objects appear as if they are *miniature models*. In real photography, you can achieve this effect with special tilt-shift camera lenses. Using the software you can bring any photo into a world of miniatures!
**Iris Blur** mode (*Deluxe/Business*) creates shallow depth-of-field effect, blurring the background while keeping the subject in focus.

In contrast to the previous mode, this one lets you specify the shape of the sharp area (ellipse, rectangle). Real photographers can achieve this effect by opening aperture and using different lenses. With this program you can create a blur background in a click.
Motion Blur mode allows to simulate the movement in static images. It creates the photographic illusion of a fast-moving object by smearing the image in the straight line direction.

You can apply the effect to either an entire image or put an accent to certain areas by blurring the background. Add action to your images!
Radial Blur mode creates a circular blurring effect normally caused by rotating or zooming the camera while shooting a picture. The mode allows you to choose between two options:

Zoom Blur option makes the image appear to move toward or away from the viewer. Spin Blur option creates the appearance that the image is spinning.

Revive your images with outstanding blur effects!
Advanced photography techniques are now available for everyone!

You do not need special knowledge to achieve good results. The software is easy-to-use, even for novices. To get started quickly, the program offers a large number of presets. You can observe the result in real time and compare before and after states.

**AKVIS Refocus** is available as a standalone application and as a plugin filter.

The plugin version is compatible with AliveColors, Adobe Photoshop, Photoshop Elements, Corel PaintShop Pro, and other editors. Check the compatibility.
**INSTALLATION**

Follow the instructions to install **AKVIS Refocus** in Windows.

- Start the setup `exe` file.
- Select your language and press the OK button to launch the installation process.
- To continue the installation process you have to read and accept the License Agreement. Activate the check box "**I accept the terms in the license agreement**", and press Next.

![License Agreement](image1)

- To install the Plugin you should select your photo editor(s) from the list.

To install the **Standalone version**, make sure that the check-box Standalone is activated. To create a shortcut for the program on desktop, activate the component **Shortcut on Desktop**.

Press the button Next.

![Custom Setup](image2)

- Press the button **Install**.

![Image 3](image3)
- The installation is in progress.

- The installation is completed.

You can subscribe to the **AKVIS Newsletter** to be informed about updates and events.
Press **Finish** to exit Setup.

After installation of the **standalone** version of Refocus, you will see a new line in the **Start** menu: **AKVIS - Refocus** and a shortcut on desktop, if during installation the component **Shortcut on Desktop** was enabled.

After installation of the **Refocus plugin** you will see a new item in the Filter/Effects menu of your photo editor. For example in Photoshop: **Filter -> AKVIS -> Refocus**. Please use this command to launch the plugin in the editor.
Follow the instructions to install **AKVIS Refocus** in a Mac computer:

- Open the virtual disk **dmg**:
  - **akvis-refocus-app.dmg** to install the **Standalone** version
  - **akvis-refocus-plugin.dmg** to install the **Plugin** to your image editor (Photoshop or Photoshop Elements).

- Read the **License Agreement** and press **Agree**, if you agree with the conditions.

- **Finder** will open with **AKVIS Refocus** application or **AKVIS Refocus PlugIn** inside.

- To install the **Standalone** version just drag the **AKVIS Refocus** application into the folder **Applications** (or any other place you like).

To install the **Plugin** drag the entire **AKVIS Refocus PlugIn** folder into the **Plug-Ins** folder of your graphic editor.

For example:

- if you use **Photoshop CC 2020**, **CC 2019**, **CC 2018**, **CC 2017**, **CC 2015.5**, copy the plugin into **Library/Application Support/Adobe/Plug-Ins/CC**;

- if you use **Photoshop CC 2015**, copy it into **Applications/Adobe Photoshop CC 2015/Plug-ins**;

- if you use **Photoshop CS6**, copy it into **Applications/Adobe Photoshop CS6/Plug-ins**.
After installation of the plugin, you will see a new item in the Filter menu of your photo editor. In Photoshop select in menu: Filter -> AKVIS -> Refocus.

Run the standalone app by double-clicking on its icon in Finder.
**HOW TO ACTIVATE AKVIS SOFTWARE**

**Attention!** During the activation process your computer must be connected to Internet.

If it is not possible, we offer you an alternative way ([see below for Offline Activation](#)).

Download [AKVIS Refocus](#) and install the program. [Read the Installation Instruction here](#).

When you run the unregistered version, a splash window will appear displaying general information about the version and the number of days left in your trial period.

You can also open the **About the Program** window by pressing the button ![in the program’s Control Panel](#).

![AKVIS Refocus](#)

**Evaluation period expires in 10 days.**
**Unregistered Version**

Click on **TRY IT** to evaluate the software. A new window will appear with variants of licenses to test.

You do not need to register the trial version to try all features of the software. Just use the program during the evaluation time (10 days after the 1st start).

During the test period you can try all options and choose the license you like. Select one of the offered functionality types: **Home** (Plugin or Standalone), **Home Deluxe**, or **Business**. Your choice of license will affect which features will be available in the program. [Consult the comparison table](#) for more details about license types and versions of the software.

If the trial period has expired, the **TRY IT** button is disabled.

Click on **BUY NOW** to choose a license to order.

When the payment is effected, your serial number for the program will be sent to you within minutes.
Click on **ACTIVATE** to start the activation process.

![Activation Screen](image)

Enter your name (the program will be registered to this name).

Enter your serial number (your license key).

Choose the method of activation — either direct connection to the activation server or by e-mail.

**Direct connection:**

- We recommend activating the program using direct connection, as it is the easiest way.
- At this step your computer must be connected to Internet.
- Press **ACTIVATE**.
- Your registration is completed!

**Request by e-mail:**

- In case you have chosen activation by e-mail, a message with all necessary information will be created by the program.

**NOTE:** You can also use this method for **Offline Activation**:

If your computer is not connected to Internet, transfer the activation message to a computer connected to Internet, for example, with a USB stick. Send us this information to: activate@akvis.com.

**Please do not send the screenshot!** Just copy the text and save it.

We need your serial number for the software, your name, and HardwareID (HWID) of your computer.

We will generate your license file (**Refocus.lic**) using this information and will send it to your e-mail address.

Save the **.lic** file (do not open it!) to your computer where you want to register the software, in the **AKVIS** folder in Users’ Shared (Public) Documents:

- **Windows Vista/7/8/10:**
Users\Public\Documents\AKVIS;

- **Mac:**

  Users/Shared/AKVIS.

Your registration is completed!

When the program is registered, **BUY NOW** turns to **UPGRADE** that lets you improve your license (for example, change **Home** to **Home Deluxe** or **Business**).
**WORKSPACE**

AKVIS Refocus can work independently as a **standalone** program or as a **plugin** to a photo editor.

*Standalone* is an independent program; you can open it by clicking on the program's icon.

To launch the standalone version, run the program directly:

- On a Windows computer - select it from the **Start** menu or use the program's shortcut.
- On a Mac computer - launch the app from the **Application** folder.

*Plugin* is an add-on for a **photo editor**, for example for Photoshop.

To call the plugin, select it from filters of your image editing program.

The **AKVIS Refocus** workspace looks like this:

![AKVIS Refocus workspace](image)

The left part of the program's window is taken by the **Image Window** with two tabs: **Before** and **After**. In the **Before** tab the original image is shown, while in the **After** tab you can see the processed image. You can switch between the windows by clicking on a tab with the left mouse button.

You can select how **Image Window** and **Before/After** tabs will be shown by adjusting the **View Modes** in the bottom part of the left panel.
In the upper part of the program's window you can see the **Control Panel** with the following buttons:

- The button ![AKVIS Refocus icon](image) opens the home page of **AKVIS Refocus**.
- The button ![Open image](image) (only in the standalone program) opens image for processing. The hot-keys for the command are **Ctrl** + O on Windows, **⌘** + O on Mac.
- The button ![Save image](image) (only in the standalone version) saves image to the disk. The hot-keys are **Ctrl** + S on Windows, **⌘** + S on Mac.
- The button ![Print](image) (only in the standalone program) opens the **Print** dialog. The hot-keys are **Ctrl** + P on Windows, **⌘** + P on Mac.
- The button ![Posting pictures](image) lets posting pictures from the program to the social networks.
- The button ![Import](image) imports a list of presets (from the .refocus file).
- The button ![Export](image) exports presets (user settings for the image processing). You can save any number of presets to a separate file with the ending .refocus.
- The button ![Batch Processing](image) (only in the standalone program) opens the **Batch Processing** dialog to automatically process a series of images.
- The button ![Open refstrokes files](image) opens files with the .refstrokes extention. These are the files where you save strokes drawn on an image.
- The button ![Save refstrokes](image) saves strokes drawn on an image into a file with the .refstrokes extension. It is helpful when you want to edit the photo later.
- The button ![Turn off refstrokes](image) / ![Turn on refstrokes](image) turns on/off the drawn strokes.
- The button ![Cancel last operation](image) cancels the last operation made with the pencils in Refocus mode. It is possible to cancel several operations in a row. The hotkeys are **Ctrl** + Z on Windows, **⌘** + Z on Mac.
- The button ![Return last cancelled operation](image) returns the last cancelled operation. It is possible to return several operations in a row. The hotkeys are **Ctrl** + Y on Windows, **⌘** + Y on Mac.
- The button ![Start processing](image) starts image processing. Use hot-keys: **Ctrl** + R on Windows, **⌘** + R on Mac.
- The button ![Apply result](image) (only in the plugin version) applies the result to the image and closes the plugin.
- The button ![Info](image) calls information about the program and opens the registration window.
- The button ![Help](image) calls the Help files. The hot-key is **F1**.
- The button ![Preferences](image) calls the **Preferences** dialog box for changing the program's options.
- The button ![News](image) opens a window showing the latest news about Refocus.

To the left of the **Image Window** there is the **Toolbar**. The tool’s parameters are shown in the **Settings Panel** and in pop-up box after right-clicking in the image window.

- The button ![History Brush](image) activates the **History Brush** tool which lets you fade the effect and restore the image, partially or fully, to its original state.

**Refocus Mode, Motion Blur, Radial Blur:**

- The button ![Quick preview](image) switches on/off the quick preview area (in Refocus mode).
- The buttons ![Activate special features](image) and ![Activate special features](image) (available only for Home Deluxe and Business licenses) activate the special
tools which are used to select processing areas.

With the blue strokes indicate the focus area, where you want to preserve or increase the sharpness.

Use red strokes to mark background objects. You can blur this area using blur modes.

The button activates the Eraser tool used to erase strokes drawn with the pencils.

Iris Blur and Tilt-Shift Modes:

The button activates the Blur Area tool that lets adjusting blur effect areas.

Additional Tools:

The button activates the Hand tool which allows you to scroll the image when it does not fit within the main window at the desired scale. To use it click on the button, bring the cursor over the image, and while keeping the left mouse button pressed move in the desired direction. Double-clicking on the tool’s icon makes the image fit the window.

The button activates the Zoom tool, which changes the image's scale. To zoom in left click on the image. To zoom out left click with Alt on the image. Press Z to quickly access the tool. Double-clicking on the tool’s icon makes the image scale to 100% (actual size).

Navigate and scale the image using the Navigator. Here you can see the reduced copy of the image. The red frame shows the part of the image that is now visible in the main window; the areas outside the frame will be shaded. Drag the frame to make other parts of the image visible. To move the frame, bring the cursor inside the frame, press the left mouse button and, keeping it pressed, move the frame in the Navigator.

Additionally, you can move the image in the main window with the scroll bars or by holding down the space bar, then holding down the left mouse button while moving the mouse. The mouse’s scroll wheel can move the image up and down, and holding Ctrl on Windows, ⌘ on Mac – while using the scroll wheel will move the image left and right. Holding Alt on Windows, Option on Mac will scale the image. Right-click on the scroll bar to activate the quick navigation menu.

Use the slider or the buttons and to scale the image in the window. When you click on the button or move the slider to the right, the image scale increases. When you click on the button or move the slider to the left, the image scale reduces.

You can also change the image scale by entering a new coefficient into the scale field. Frequently used scale coefficients can be found in a drop-down menu.

You can use hot-keys to change the image scale + and Ctrl++ on Windows, ⌘++ on Mac to increase
the image scale and and Ctrl+ on Windows, ⌘+ on Mac to reduce the scale.

Below the **Navigator** is the **Settings Panel** where you can select a mode and adjust its settings.

In the **Presets** field you can save favorite settings as a preset to use them in the future. When you launch the program, it uses the settings of the last used preset.

Under the **Settings Panel** you can see **Hints** for the parameters and buttons when you hover over them with the cursor. You can choose where the hints will be shown or hide them in the program's **Preferences**.
IMAGE VIEW MODES: BEFORE AND AFTER

At the bottom of the Toolbar of AKVIS Refocus, there are three buttons which let you choose how the Image Window will look like and arrange the Before and After tabs.

- Click the first button to open a submenu that contains various options for viewing the original and processed images:
  - The button provides the standard image window mode with two tabs: Before and After.
  - The buttons and divide the main window into two parts, vertically or horizontally, respectively. The original and processed images become partially visible and the tabs are combined to form the whole picture.

With this arrangement, it's possible to drag the splitter changing the aspect ratio between the Before and After parts.

- The buttons and split the main window into two parts, vertically or horizontally, as well. However, in contrast to the previous option, the windows display the same fragment of the image before and after processing.
Note: Use two windows side by side when you want to see and compare the original and processed versions of an image fragment on one screen. If you would rather see the final image as a whole, you can choose the standard image view mode.

- The button swaps the positions of the original image and result when displaying two windows.
- The 3rd button lets you choose the background color of the Image Window. Pressing or changes the background color to white, gray, or black, while clicking on opens the Select Color dialog where you can choose a color of your choice.
**HOW IT WORKS**

**AKVIS Refocus** improves sharpness of out of focus images and adds artistic blur effects to your photos. The software can work independently as a *standalone* program as well as a *plugin* to a photo editor.

Follow the instructions below:

**Step 1.** Load an image into the software.

- If you work with the standalone edition:
  
  To open an image in the program, you can double-click in the empty workspace of Refocus or drag the image into the workspace, or press 📈 on the **Control Panel**. The program supports **BMP**, **JPEG**, **PNG**, **TIFF** and **RAW** file formats.

- If you work with the plugin:
  
  Open an image in your photo editor by calling the command **File -> Open** or using the key combination **Ctrl + O** on Windows, **⌘ + O** on Mac.

  Then call the **AKVIS Refocus** plug-in:

  In **AliveColors**: Effects -> AKVIS -> Refocus;
  in **Adobe Photoshop**: Filter -> AKVIS -> Refocus;
  in **Corel Paint Shop Pro**: Effects -> Plugins -> AKVIS -> Refocus;
  in **Corel Photo-Paint**: Effects -> AKVIS -> Refocus.

**Step 2.** Select the processing mode in the drop-down menu in the **Settings Panel**:

- **Refocus** mode improves sharpness of blurred images. You can re-focus the entire image or only certain details.
- **Tilt-Shift** mode adds the objects on the photo a toy look. This effect "miniaturizes" the image, blurring the outer parts and making the objects appear as if they are models.
- **Iris Blur** mode creates shallow depth-of-field effect, blurring the background while keeping the subject in focus. This mode is only available for the **Home Deluxe and Business** licenses.
- **Motion Blur.** This blur method imitates the straight line motion of a camera.
Radial Blur. This method imitates the effect of rotating camera and blurring from the center.

Note that Refocus mode sharpens the image, and the other four are the blur effects. Usually (but not obligatory) Iris Blur fits better for portraits, Tilt-Shift - for landscapes, Motion Blur - for linear moving objects (for example, a car), Radial Blur - for circular objects (for example, wheels of a moving car).

**Step 3.** Adjust the parameters in the **Settings Panel**.

![Settings Panel](image)

**Step 4.** It is possible to save the settings you like as a preset and use them in the future.

**Note** that the presets save only the parameters values in the **Settings Panel**, and do not save the lines which define the effect area.

To save a preset, enter a name for the preset into the **Presets** field and press the button **Save**. Now, as you start the program, it will use the settings of this preset. If you change the values of the parameters, you can always come back to the default settings of the preset by pressing the **Reset** button.

To delete a preset, select it from the list and press **Delete**.

To process an image with the settings of a certain preset, select it from the drop-down menu.

**Step 5.** Share your work by clicking on ![Share Button](image). It opens the list of the services where you can publish the image.

In the standalone version, you can also print your image with ![Print Button](image).

**Step 6.** Save the resulting image.

- If you work with the standalone program:

  Click on the button ![Save As Button](image) to open the **Save As** dialog box. Enter a name for the file, choose
the format (TIFF, BMP, JPEG or PNG) and indicate the target folder.

- If you work with the plugin:

  Apply the result by pressing ✓. The Refocus plugin will close and the picture will appear in the photo editor’s workspace.

  Call the **Save As** dialog box using the command **File -> Save As**, enter a name for the file, choose the format and indicate the target folder.
REFOCUS MODE

Use Refocus mode to improve sharpness of blurred images. It lets you re-focus the entire image or bring only certain elements of the image into focus.

Follow the steps below to improve the focus of your image using Refocus mode:

**Step 1.** The photo will be processed with the default parameter values (the AKVIS Default preset) and the result will be immediately shown in the quick preview window.

You can drag the preview area to analyze the effect on the different parts of the photo. Click within the preview to compare the processed sample with the original image. It can be switched on/off with the button . Change the size of the preview in Preferences .
**Step 2.** Adjust the settings to achieve the best result.

Choose the refocusing settings:

**Smoothing** (1-10). The parameter sets the level of smoothness. The higher its value, the stronger the influence of the other parameters is.

**Color Blur** (1-10). The parameter is used for alignment of colors to a uniform state that lets removing fringing and halos. It is especially effective in tandem with the previous parameter.

**Level of Detail** (0-50). The parameter strengthens details on an image. Note that at higher values it can produce noise.

**Sharpness** (0-50). The parameter changes intensity of the refocusing effect.
Remove Noise. This option lets reducing the side effects which can appear on the image (digital noise, grain, artifacts).

Step 3. You can process only certain areas using the tools and .

Note that this feature is only available for Home Deluxe and Business licenses.
Focus Area. Use the blue pencil to select areas to be processed with the above mentioned settings.

Background Area. Use the red pencil to outline parts that will remain in their original state or will be blurred.

Adjust Background Defocus -> Blur (0-1000). The areas marked with red will be blurred. This option will help you achieve the realistic selective focus effect.

Eraser. Use the tool to erase the red and blue strokes. The tool works in three modes:

- erase all strokes;
- erase only red strokes;
- erase only blue strokes;

Hints: It is better to draw a closed outline around the objects. Otherwise the effect can extend over the drawn borders.

You can adjust the Size of the tools in a pop-up window that appears after right clicking in
Step 4. Click to start image processing. You can interrupt the process by clicking on the Cancel button right to the progress bar.

Step 5. If you like the new settings you can save them as a Preset and use them later. Enter a name for your new preset and press the button Save.

Note that the presets save only the parameters values in the Settings Panel, and do not save the areas selected with the tools.
**TILT-SHIFT MODE**

*Tilt-Shift* mode allows leaving a sharp strip in the image, adding gradual blur at the edges, with smooth transitions between the regions. This mode gives the objects on the photo a "toy" look. It blurs the outer parts and makes the objects appear as if they are miniature models. It looks like the program transforms full size people, buildings, cars into their tiny versions.

In real photography, you can achieve this effect with special tilt-shift camera lenses. Using **AKVIS Refocus** you can bring any photo into a world of miniatures.

Follow the steps below to apply this effect to a photo:

**Step 1.** Adjust the **Preview** option:

- **Fast Preview** - this option lets you try the settings on a smaller copy of the original image.
- **Full Processing** - the image in its original size will be processed with the chosen parameters.

Processing will start automatically, in the visible part of the image, every time you change a parameter or the effect area.

Once you have adjusted the parameters, it is recommended to try the full processing to make sure that the best settings are chosen. Choose the **Full Processing** option or click on to process the entire image.

**Step 2.** Activate the **Blur Area** tool and adjust the area of effect with the markers that appear over the image in the **After** tab.
- **solid lines** help to adjust the size of the un-blurred area;
- **dots** are used to rotate the effect area;
- **internal dashed lines** let adjusting smooth transition between blurred and un-blurred areas;
- **external dashed lines** define the area of maximum blur.

To move the area, place the cursor in the un-blurred part (it will turn into crossed arrows 🔄) and drag holding down the left mouse button.

To re-size any section, put the cursor on the line bounding this area (it will look like a double arrow ↔️) and drag with the left mouse button.

To rotate the area, place the cursor over a dot (it will turn into a rounded double-sided arrow ⬅️️) and move holding down the left mouse button.
**Step 3.** You can use one of the ready-to-use *presets* or adjust the parameters.

The **Blur** parameter lets you adjust the strength of the blur effect. The higher the value, the greater the blur is.

![Blur comparison](image1.png)

**Step 4.** All light spots in the out-of-focus region take the form of bright glare. By default, they look like round discs.

You can change their shape by adjusting the parameters of the **Bokeh Shape** section.

Using the **Glow** parameters, you can increase the brightness and saturation of light spots.
Step 5. Press the button to start processing of the entire image.

Step 6. The program lets you save your favorite settings as a preset and use them in the future. 

Note that the presets save only the parameters values in the Settings Panel, and do not save the effect area.
IRIS BLUR MODE

Iris Blur mode creates shallow depth-of-field effect, blurring the background while keeping the subject in focus. In contrast to Tilt-Shift mode, this one lets you specify the shape of the sharp area (ellipse, rectangle).

Real photographers can achieve this effect by opening aperture and using different lenses. With AKVIS Refocus you can create a blur background in a click.

Note: This mode is only available for the Home Deluxe and Business licenses. Compare the licenses here.

Follow the steps below to apply this effect to a photo:

Step 1. Adjust the Preview option:

    Fast Preview - this option lets you try the settings on a smaller copy of the original image.
    Full Processing - the image in its original size will be processed with the chosen parameters.

Processing will start automatically, in the visible part of the image, every time you change a parameter or the effect area.

Once you have adjusted the parameters, it is recommended to try the full processing to make sure that the best settings are chosen. Choose the Full Processing option or click on to process the entire image.

Step 2. Activate the Blur Area tool and adjust the effect area with the markers that appear over the image in the After tab.
- **solid line** helps to adjust the size of the un-blurred area;
- **dots** are used to rotate, stretch, or compress the effect area;
- **square markers** help to change a form of an ellipse.
- **internal dashed line** lets adjusting smooth transition between blurred and un-blurred areas;
- **external dashed line** defines the area of maximum blur.

To move the area, place the cursor in the un-blurred part (it will turn into crossed arrows) and drag holding down the left mouse button.

To re-size any section, put the cursor on the line bounding this area (it will look like a double arrow) and drag with the left mouse button.

To rotate, stretch, or compress the area, place the cursor over a dot (it will turn into a rounded double-sided arrow) and move holding down the left mouse button.

To change a form of the area, drag a square marker.
**Step 3.** Use one of the ready-to-use presets or adjust the parameters.

The **Blur** parameter lets you adjust the strength of the blur effect. The higher the value, the greater the blur is.

![Blur 25](image1.png) ![Blur 50](image2.png)

**Step 4.** All light spots in the out-of-focus region take the form of bright glare. By default, they look like round discs.

You can change their shape by adjusting the parameters of the **Bokeh Shape** section.

Using the **Glow** parameters, you can increase the brightness and saturation of light spots.
**Iris Blur Effect**

**Step 5.** Press the button to start processing of the entire image.

**Step 6.** The program lets you save your favorite settings as a preset and use them in the future.

**Note** that the presets save only the parameters values in the **Settings Panel**, and do not save the effect area.
**MOTION BLUR**

**Motion Blur** mode imitates the straight line motion of a camera.

Parameters:

**Angle** (0-180). This parameter sets the inclination angle of the line, along which the effect will expand to the image. The values of the parameter vary between 0 and 180 degrees. At exactly these values the blurring will be horizontal. At value = 90 the blurring will be vertical.
**Distance** (1-500). This parameter defines the effect application area in pixels (relative to every point of the image).

![Distance 100](image1.jpg)  ![Distance 300](image2.jpg)

You can process only certain areas using the tools `brush` and `eraser`.

Note that this feature is only available for Home Deluxe and Business licenses.
**RADIAL BLUR**

**Radial Blur** mode blurs the area around a specific point, simulating the result of a zooming or rotating camera.

In the **Blur Center** section, you can determine the position of the central blur point. To set the position, activate the icon and click the image or move the white marker. The current coordinates are shown in the fields X and Y.

There are two kinds of radial blur:

- **Zoom.** This mode creates blurring directed away from the center.
- **Spin.** This mode imitates the effect of a camera rotating around the central point of the image, which results in circular blurring.

Adjust the blur area with the following parameters:

- **Highlights** (1-100). The intensity of blurring in light areas.
- **Shadows** (1-100). The intensity of blurring in dark areas.
You can process only certain areas using the tools [image] and [image].

Note that this feature is only available for Home Deluxe and Business licenses.
**BOKEH EFFECTS**

**Bokeh** is out-of-focus areas in a photo. Bokeh is determined by the way how the lens renders unsharp points of light. It's often used for creating artistic effects - to blur backgrounds for visual selection of a main object in a scene. In photography, bokeh effect depends on the shape of the aperture. Various shapes let you achieve artistic background blur effects, for example with stars.

With the program **AKVIS Refocus** you can make a variety of figure bokeh on any photo.

Note. Bokeh effects are available in **Tilt-Shift** and **Iris Blur** modes.

*Bokeh Effects*

Use these parameters to adjust the look of the spots of light in the blurred area:

**Bokeh Shape** Parameter Group.

**Shape.** Click on the square button in the **Settings Panel** and select a shape from a list. All light spots in the out-of-focus area will change in the selected shape:

<table>
<thead>
<tr>
<th>Bokeh Shapes</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Bokeh Shapes" /></td>
</tr>
</tbody>
</table>

**Smoothness** (-100..100). At the value = 0, the spots of light have the selected form. The higher the value, the more the edges of the light spots are blurry and out of focus. When decreasing the value, the center of the light spot is blurred and becomes more transparent. At the lowest value, the only contours of the shape remain visible.
**Deformation** (-100..100). When the parameter is set to 0, the light spots have a polygonal shape. The higher the value, the more the edges of the polygon are curved outside, making it gradually look like a circle. The less the value, the more the edges are retracted inside the shape, turning the polygon into a star.

**Rotation** (0-360). The parameter defines the rotation angle of the polygon around its center.

**Note:** **Deformation** and **Rotation** parameters are disabled for the 1st shape (circle).

**Glow** Parameter Group.

**Brightness** (0-100). As the parameter increases, the brightness of the light spots increases.
**Saturation** (0-100). The parameter increases the color saturation of light spots. The parameter is associated with the Brightness parameter. The higher the Brightness, the more saturated colors you can get.

<table>
<thead>
<tr>
<th>Brightness</th>
<th>Saturation</th>
</tr>
</thead>
<tbody>
<tr>
<td>25</td>
<td>25</td>
</tr>
<tr>
<td>75</td>
<td>75</td>
</tr>
</tbody>
</table>

**Range** (0-255). The parameter specifies the brightness range of light spots to which the first 2 parameters will be applied.

<table>
<thead>
<tr>
<th>Range</th>
<th>Brightness</th>
</tr>
</thead>
<tbody>
<tr>
<td>200/225</td>
<td>25</td>
</tr>
<tr>
<td>240/250</td>
<td>75</td>
</tr>
</tbody>
</table>
PROGRAM PREFERENCES

The button opens the Preferences dialog box. It looks like this:

- **Language.** Change the program language by selecting another from the drop-down list.
- **Interface Scale.** Choose the size of the interface elements. When it is set to Auto, the program workspace will automatically scale to fit the screen resolution.
- **Interface Theme.** Select the style of the program interface: Light, Gray, or Dark.
- **Initial Image Scale.** This option defines the way the image is scaled in the Image Window.
  - **Fit to View:** the image is completely visible in the window;
  - **100%:** the image doesn’t scale (generally, only a part of the image is visible).

- **Preview Window Size.** You can change the size of the quick preview area for Refocus mode: from 200x200 to 1000x1000 pixels. By default, the parameter’s value = 500, that is the preview area has a proportion 500x500 px.
- **Hints Panel.** When you hover over parameters and buttons with the cursor you can see a brief description of them in the Hints field. You can choose how the hints will be shown:
  - **Under Image Window.** It shows the hints in the main window, under the image. This mode is useful if there is not enough space by height to display this field under the settings;
  - **Under Settings Panel.** Select this to show hints at the bottom of the right part, under the settings;
  - **Hide.** Use this option if you do not need the hints.

- **Recent Files** (available only in the standalone version). The number of recent documents. The list of the recent files, sorted by time, become visible by right mouse clicking on . Maximum: 30 files.
- **Use OS File Dialog** check-box. Enable this option if you want to use the System Open/Save Dialog. Otherwise, the AKVIS File Dialog is used.
- **Lock the Control Panel** check-box. It disables the possibility to hide/show the top panel. If the check-box is selected the panel is always visible.
To save changes made in the Preferences window press OK.

If you need, click on the button Default to come back the default settings.
**BATCH PROCESSING**

**AKVIS Refocus** supports the time-saving **Batch Processing** feature. It lets you automatically edit a series of out-of-focus images with the same settings. Just select a preset and apply it to a folder full of photos - the program will do the rest automatically!

![Image of AKVIS Refocus Batch Processing interface](image)

Even if you've never used this feature before it is simple to learn.

If you use the standalone version of **AKVIS Refocus**, [read the instructions here](#).

If you use the **Refocus** plugin in Photoshop, [use this tutorial](#).
PRINT IMAGES IN AKVIS REFOCUS

In the standalone version of AKVIS Refocus you can print the image. Press the button to open the Print options.

Adjust the parameters appearing in the Settings Panel:

Choose a printer from the list of available devices, set the desired resolution, as well as the number of copies to print.

In the Orientation group, set the position of paper: Portrait (vertically) or Landscape (horizontally).

Click the Page Setup button to open a dialog box to choose the size of the paper and its orientation, as well as the print margins.

Press the Reset Margins button to return the page margins to the default size.

Change the size of the printed image adjusting the parameters Scale, Width, Height and Fit to Page. These parameters have no effect on the image itself, just on the print version. You can change the size of the printed image by entering any value in %, or by entering new values in Width and Height.

To adjust the size of the image to the paper size, select Fit to Page.

Move the image on the page with the mouse or align it using the arrow buttons.

You can activate Frame for the image and adjust its width and color.

Choose the Background Color by clicking on the color plate.
In the **Page** tab, you can adjust printing of the multiple copies of the image on a single sheet.

- **Copies per Page.** It lets you specify the number of copies of the image on one page.
- **Horizontally** and **Vertically.** These parameters indicate the number of rows and columns for the copies of the image on the page.
- **Spacing.** The parameter sets the margins between the copies of the image.

In the **Poster** tab, it's possible to customize printing of the image on multiple pages for the subsequent junction into a large picture.

- **Pages.** If the check-box is enabled, you can specify the maximum number of the pages in which the image will be divided. The image scale will be adjusted to fit this number of the sheets. If the check-box is disabled, the program will automatically select the optimal number of the pages in accordance with the actual size of the image (scale = 100%).
○ **Glue Margins.** If the check-box is enabled, you can adjust the width of the padding for bonding sheets. Margins will be added to the right and to the bottom of each part.
○ **Lines of Cut.** Activate the check-box to display the cut marks in the margins.
○ **Show Numbers.** With the enabled check-box, a sequence number of each part, by a column and a row, will be printed in the margins.

To print the image with the chosen parameters, press the **Print** button. To cancel and close the printing options click on **Cancel**.

Click the **Properties...** button to open a system dialog box that enables you to access the advanced settings and send the document to print.
TOY WORLD

*Tilt-Shift* effect makes a photo of a full-scale object or scene look like a toy. Usually this effect is achieved with special lenses, but we will obtain the same result using **AKVIS Refocus**.

For best results, use a photo where the point of view is several meters above the subject or scene. There should be many small objects in the scene: buildings, people, cars, etc. The sky should not be visible.

We’ll show you 2 ways to create a *tilt-shift image* in **AKVIS Refocus**: using **Tilt-Shift** mode or using **Refocus** mode.

**Method 1.** Image processing in **Tilt-Shift** mode.

*Step 1.* Select the **Tilt Shift** mode in the drop-down menu in the **Settings Panel**:

*Step 2.* Define the blur effect area with the markers that appear over the image when the tool is active.

*Step 3.* Choose one of the ready-to-use presets or adjust the parameters to your liking.
Here is the result:

Result: Tilt-Shift Effect

**Method 2.** Image processing in **Refocus** mode.

This time we chose a photo of a small square taken from a ferris wheel.
Step 1. Select the **Refocus** mode in the drop-down menu in the **Settings Panel**.

Step 2. Activate ☑️ and draw blue lines around the area that will be sharpened.
Then select and draw red lines within the area that will be blurred.

**Step 3.** Adjust the parameters. Set **Blur** at maximum value.

**Step 4.** Press to start image processing.

Here is the result:
As you can see, it's easy to make a **Tilt-Shift** effect with **AKVIS Refocus**!
AKVIS Refocus is designed to produce clear images from blurry photos. Even if you think a photo is clear enough you can always choose to improve individual areas, such as the eyes. And who knows what magic will be found in such an appealing gaze?..

It's easy to create a selective focus effect with AKVIS Refocus.

**Step 1.** Start AKVIS Refocus and open (by pressing 📷) the photograph of the unknown mysterious smiling princess. The beauty of the girl’s face is somewhat dampened by the blurriness of the photo.

**Step 2.** The preview window can help you select the best options for making the colors more vivid and expressive and the image clearer.
Step 3. The startling clarity with which she emerges from the background detracts somewhat from the overall impression of the photo. To focus just on the eyes, change the processed area: mark areas to be processed in blue using the tool, and mark the areas which will not be processed in red using the tool. We will also select a dress to make it (especially the decoration pattern) more expressive.

If you wish the rest parts can be a little blurred. We will keep them untouched (Blur = 0).
Marking Areas With Strokes

Press to reprocess the image. The result looks very natural and beautiful:
AKVIS PROGRAMS

AKVIS AirBrush — Airbrushing Techniques on Your Photos
(Windows | Mac)

AKVIS AirBrush automatically transforms a photograph into a work of art which looks like made with a special airbrush tool that sprays paints or inks. The software works as an artistic filter creating stylish colorful airbrush designs from images using chosen settings of photo-to-painting conversion. More...

AKVIS ArtSuite — Frames and Effects for Your Photos
(Windows | Mac)

AKVIS ArtSuite is an impressive collection of versatile frames and effects for photos. ArtSuite contains many templates and texture samples that can be used to create a virtually limitless variety of options for generating frames. Decorate a photo to give it an original and festive look! More...
AKVIS ArtWork — Collection of Painting & Drawing Techniques

(Windows | Mac)

AKVIS ArtWork is photo to painting software designed to imitate different painting techniques - *Oil Painting, Watercolor, Gouache, Comics, Pen & Ink, Linocut, Pastel, and Pointillism*. ArtWork helps you to create a piece of art out of any picture! More...
**AKVIS Chameleon — Photo Collage Creation**

(Windows | Mac)

**AKVIS Chameleon** is a fun to use tool for photo collage creation. It makes the process easy and entertaining. The tool is very easy to handle as it does not require precise selection of objects. Using the software you can quickly create your own photo collages. More...

**AKVIS Charcoal — Charcoal & Chalk Drawings**

(Windows | Mac)

**AKVIS Charcoal** is a creative tool for conversion of photos into charcoal and chalk drawings. Using the program you can make professional-looking expressive black and white images. Playing with colors and options you can achieve outstanding artistic effects, such as sanguine and others. More...

**AKVIS Coloriage — Add Color to Black and White Photos**

(Windows | Mac)

**AKVIS Coloriage** allows colorizing B&W photos and replacing colors in color images, performing selective colorization and desaturation. It helps to breathe new life into your old family photographs, bring a vintage or artistic appearance to your digital images. More...
AKVIS Decorator — Resurface and Recolor

(Windows | Mac)

AKVIS Decorator lets you change the surface of an object in a realistic manner. The program puts on a texture keeping the volume of an object, following its folds and creases. The new pattern looks absolutely natural and makes you see things differently. Recoloring is also made easy. More...

AKVIS Draw — Hand-made Pencil Drawing Effect

(Windows | Mac)

AKVIS Draw converts your photos into hand made pencil drawings. The software creates realistic looking line art illustrations, produces both B&W and color drawings. Add a hand-drawn look to your pictures! More...
**AKVIS Enhancer — Bring Detail To Your Pictures**

(Windows | Mac)

**AKVIS Enhancer** is image enhancement software that detects detail in underexposed, overexposed and mid tone areas of a photo with uneven exposure. Enhancer improves every part of the image! The software works in three modes: Improve Detail, Prepress, and Tone Correction. The program offers a fast method to fix a dark photo, add contrast and brightness to a picture, it lets you improve color and adjust tones. More...

![Tortoise Comparison](image)

**AKVIS Explosion — Fabulous Particle Explosion Effects**

(Windows | Mac)

**AKVIS Explosion** offers creative destruction and particle explosion effects for your photos. It bursts an object and applies dust and sand particles to an image. With the software, you can create eye-catching graphics in just a few minutes! More...

**AKVIS Frames — Decorate Your Photos with Frames**

(Windows | Mac)

**AKVIS Frames** is free software designed for working with the AKVIS frame packs

![Frame Examples](image)

**AKVIS HDRFactory — High Dynamic Range Images: Brighter than Reality!**

(Windows | Mac)

**AKVIS HDRFactory** lets you create a High Dynamic Range image from a series of shots or from one single photo. The program can also be used for photo correction. The program brings life and color to your
AKVIS LightShop — Light and Star Effects
(Windows | Mac)

**AKVIS LightShop** lets you create an infinite number of astounding light effects! The program offers advanced lighting techniques for adding stars and glow effects to images. A light effect draws attention and brighten up any photo. Add a little magic to your pictures! More...

AKVIS Magnifier — Change Image Size without Quality Loss
(Windows | Mac)

**AKVIS Magnifier** helps to resize images without loss in quality. Whether creating poster-size images, adding resolution for printing an enlargement, or reducing image size, Magnifier will make your prints look sharper and better defined. More...
AKVIS MakeUp — Retouch Your Portrait Photos!

(Windows | Mac)

AKVIS MakeUp improves your portraits giving them a professional look. The software retouches facial imperfections making your skin radiant, beautiful, pure and even. The program adds glamour to your pictures and creates a high key effect. Look your best in every photo with AKVIS MakeUp! More...

AKVIS NatureArt — Bring Nature to Your Photos

(Windows | Mac)

AKVIS NatureArt is an excellent tool for imitating the magnificence of natural phenomena on your photos. The program includes a number of effects: Rain
AKVIS Neon — Glowing Drawings from Photos

(Windows | Mac)

AKVIS Neon lets you create amazing glowing lines effects. The software transforms a photo into a neon image that looks like drawn with luminescent ink. More...

AKVIS Noise Buster — Digital Noise Reduction

(Windows | Mac)

AKVIS Noise Buster is software for noise suppression on digital and scanned images. Digital noise can be
seen as artifacts and random red and blue pixels that compromise the smoothness of a photo. The program is efficient against both color and luminance noise. More...

AKVIS OilPaint — Oil Painting Effect

(Windows | Mac)

**AKVIS OilPaint** turns your photos into oil paintings. The mysterious production of a painting happens right before your eyes. The unique algorithm authentically reproduces the technique of the real brush. With this cutting-edge software you can become a painter! More...

AKVIS Pastel — Turn Photos into Pastel Paintings

(Windows | Mac)

**AKVIS Pastel** turns your photos into pastel paintings. The program converts your photo into a lifelike digital art imitating one of the most popular artistic techniques. AKVIS Pastel is a powerful tool to unleash your creativity! More...
AKVIS Points — Apply Pointillism Effect to Your Photos

(Windows | Mac)

AKVIS Points lets you transform your photos into paintings using one of the most exciting artistic techniques - pointillism. With the software you can easily create gorgeous works of art in a pointillist manner. Discover the world of bright colors! More...

AKVIS Refocus — Focus Improvement & Blur Effects

(Windows | Mac)

AKVIS Refocus improves sharpness of out of focus photos, enhances the entire image or partially, creating selectively focused area. It’s also possible to add bokeh and lens blur effects to your photos. The program provides five image processing modes: Refocus, Tilt-Shift, Iris Blur, Motion Blur, and Radial Blur. More...
**AKVIS Retoucher — Image Restoration Software**

(Windows | Mac)

**AKVIS Retoucher** is an efficient program for photo restoration and photo retouching. The software removes dust, scratches, stains, and other defects that appear on damaged photos. It intelligently reconstructs the missing parts of the photo using the information of the surrounding areas. [More...](#)

**AKVIS Sketch — Turn Your Photos into Pencil Sketches**

(Windows | Mac)

**AKVIS Sketch** converts digital photos into amazing pencil drawings. The software creates realistic color artworks and B&W sketches, imitates the technique of graphite and color pencil, and even generates the charcoal, pastel, and watercolor effects. [More...](#)
AKVIS SmartMask — Save Time on Complex Selections!
(Windows | Mac)

AKVIS SmartMask is an efficient selection tool that saves time and is fun to use. Selection has never been so simple! The software considerably increases your productivity. You will be freed from boring work and will have more room for creativity and realization of your ideas. More...

AKVIS Watercolor — Aquarelle Art from Photos
(Windows | Mac)

AKVIS Watercolor easily makes a photo look like a brilliant and vibrant watercolor painting. The software turns ordinary images into amazingly realistic aquarelle pieces of art. More...